
 

 

 

Dream Report® 
 

Industrial Reporting and Analysis 
 
 

GETTING STARTED GUIDE 
 

Rev. 2019-06-24 

 
 
 
 

www.dreamreport.com 

 

© Ocean Data Systems Ltd., All rights reserved. 
  

http://www.dreamreport.net/


   

Dream Report Getting Started Guide  

 

2 | P a g e  

 
Web site: www.dreamreport.com     Email: contact@dreamreport.net   support@dreamreport.com 

Table of Contents 
Preface .............................................................................................................................................................. 3 

Welcome to Dream Report ........................................................................................................................... 3 

About this document ................................................................................................................................ 3 

Audience ................................................................................................................................................... 4 

About Dream Report ................................................................................................................................. 4 

Installing Dream Report ............................................................................................................................ 4 

Dream Report Installation - Folder Organization ...................................................................................... 5 

Licensing Dream Report ............................................................................................................................ 5 

Dream Report Product Overview .................................................................................................................. 6 

Dream Report Architecture ....................................................................................................................... 6 

Chapter 1. Creating a Dream Report Project ..................................................................................................... 7 

Step 1. Start Dream Report ....................................................................................................................... 8 

Step 2. Create a New Project ..................................................................................................................... 9 

Step 3. Configure Communication Driver(s) .............................................................................................. 9 

Step 4.  Data Logging (optional) ........................................................................................................... 10 

Step 5. Create Data Model(s) .................................................................................................................. 13 

Step 6.  Batch Definition (optional) ...................................................................................................... 15 

Step 7.   Create a Report ....................................................................................................................... 16 

Step 8.  Designing and Configuring a Report ........................................................................................ 19 

Step 9.  Saving and Generating a Report .............................................................................................. 22 

Chapter 2. Dream Report Runtime .................................................................................................................. 23 

Step 10. Runtime Management and Report Generation ....................................................................... 23 

Chapter 3. Dream Report Web Portal ............................................................................................................. 26 

Step 11. Configure the Dream Report Web Portal................................................................................. 26 

Chapter 4.  Project Tools and Customization ............................................................................................. 29 

Customer Feedback ......................................................................................................................................... 31 

 

 

 

http://www.dreamreport.com/
mailto:contact@dreamreport.net
mailto:support@dreamreport.com


   

Dream Report Getting Started Guide  

 

3 | P a g e  

 
Web site: www.dreamreport.com     Email: contact@dreamreport.net   support@dreamreport.com 

Preface 

Welcome to Dream Report 
This Getting Started guide should be used as a starting point for installing Dream Report, creating a new 
project, running the project, and setting up the DR Web Portal.   

 

About this document 

 
This document contains 4 chapters. We suggest you follow them in order when creating your first 
Dream Report project. 
 
Chapter 1 “Creating a Project in Dream Report” takes you step-by-step through the process of 
creating a project in the Dream Report Studio, giving you the basic (and required) steps on how to: 

• Creating a new reporting project 

• Connecting to data sources 

• Configuring data logging 

• Configuring reports and report settings 
 
Chapter 2 “Dream Report Runtime” gives an overview of the Dream Report runtime functionality, 
which executes the project runtime tasks and report generation.   
 
Chapter 3 “Dream Report Web Portal” describes how to configure the Dream Report web portal, 
and covers the main functionality and features of the web portal. 
 
Chapter 4 “Project Customization Settings and Tools” describes special Dream Report tools and 
modules which you can use customize your project and optimize performance. This chapter is aimed 
at those users who want to explore more of the wide range of functions and features which Dream 
Report offers. 

 

 NOTE: 

The Dream Report Getting Started Guide is not meant as a substitute for the Dream Report 

User Manual, which gets installed with the software (available as a PDF document and from 

online help/F1.)  This guide should be used to get you started with installing Dream Report 

and creating your first project, and should be used in conjunction with the User Manual, 

when you need detailed explanations of features mentioned here.  Additional learning 

resources are the Dream Report Video Tutorials, Tech Notes and FAQ’s on the Dream Report 

Knowledge Base website 

(https://dreamreport.atlassian.net/wiki/spaces/DreamReport/overview). 

 

http://www.dreamreport.com/
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Audience 

This manual is intended for the first-time Dream Report users. 

 

About Dream Report 

Dream Report is the first programming free, user-friendly, automated reporting and data analysis 
software designed specifically for industrial automation applications. It is designed to be the simplest 
solution for extracting data from virtually any data source (real-time data, historical data sources, 
and historical alarm and event data), providing automated reports to anybody, anywhere and 
anytime. 

 

Installing Dream Report  
The Dream Report installation software is available either as a download from Ocean Data Systems’ 
website, or on the installation media you may have received.  The following is a checklist to get you 
started with your Dream Report installation, and should be followed in this order: 
 

1) Download the Dream Report installation: 

https://dreamreport.net/downloads/ 

2) Check Minimum System Requirements: 

https://dreamreport.net/wp-content/uploads/System-Specifications.pdf 

3) Check Support Matrix for supported operating systems and database platforms: 

https://dreamreport.atlassian.net/wiki/spaces/DreamReport/pages/491646/Compatibility+

Matrix  

4) Setup IIS Prerequisites (required for the Dream Report Web Portal): 

https://dreamreport.atlassian.net/wiki/spaces/DreamReport/pages/491702/Manual+Confi

guration+of+IIS+for+use+with+Dream+Report+Web+Portal 

5) Make sure a PDF File Viewer is installed – the install for Adobe Reader™ is included in 

ODS\Dream Report\Utilities\ and can be installed after installing Dream Report  

6) Install the Dream Report software, making sure to specify: 

- Installation location (default is C:\ODS\Dream Report\, and may be changed) 

- Communication Drivers – select specific drivers that are needed, or all (for a Demo 

system, consider installing all Communication Drivers.) 

7) Complete the installation and reboot. 

 
  

http://www.dreamreport.com/
mailto:contact@dreamreport.net
mailto:support@dreamreport.com
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https://dreamreport.atlassian.net/wiki/spaces/DreamReport/pages/491646/Compatibility+Matrix
https://dreamreport.atlassian.net/wiki/spaces/DreamReport/pages/491646/Compatibility+Matrix
https://dreamreport.atlassian.net/wiki/spaces/DreamReport/pages/491702/Manual+Configuration+of+IIS+for+use+with+Dream+Report+Web+Portal
https://dreamreport.atlassian.net/wiki/spaces/DreamReport/pages/491702/Manual+Configuration+of+IIS+for+use+with+Dream+Report+Web+Portal
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Dream Report Installation - Folder Organization 

By default, Dream Report installs itself in: “C:\ODS\Dream Report”.  It also creates the following 
folders: 

• Clipart – Library of Icons, Images and Report Backgrounds 

• Dashboard – for the Dashboard designer and integration files 

• Database – Multilanguage files (Lexicon.mdb and LexiconWeb.mdb) 

• Documentation – Release Notes with the latest information about the Dream Report release, 
User Manual, Version Upgrade Procedure, Getting Started Guide, and the Eurotherm® UUH 
Import Tool guide. 

• DR_Web_Portal – Web Portal configuration files; 

• DR_Web_Portal_Mobile – Mobile Web Portal configuration files; 

• Help – Dream Report Online help file 

• License – Dream Report license 

• ODBC Profiles – preconfigured (or user-defined) ODBC profiles for the Dream Report 
Advanced ODBC driver 

• Project – All projects saved by default as subdirectories in this folder 

• Redist – installation prerequisite file(s) 

• ScriptObjLib – object library files for Graphical Script Objects 

• System – All system application and configuration files 

• Templates – All saved page and report templates; 

• Utilities – Install programs for utilities that might be required for Dream Report (Adobe 
Reader, OPC Core component, SQL Server Client drivers, HASP driver, Debug tool, etc.) 

• WebAppTemplate  
 

Licensing Dream Report  

Dream Report is licensed in several ways: 

• Registered and Activated using the links under the Help menu in Dream Report Studio (you 
will need the License ID included in your order confirmation from Ocean Data Systems) 

• Using an Ocean Data Systems-issued USB license dongle (key) 

• Through the licensing mechanism of the Dream Report OEM partner providing the license 

  

http://www.dreamreport.com/
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Dream Report Product Overview 

Dream Report Architecture 

 

http://www.dreamreport.com/
mailto:contact@dreamreport.net
mailto:support@dreamreport.com


   

Dream Report Getting Started Guide  

 

7 | P a g e  

 
Web site: www.dreamreport.com     Email: contact@dreamreport.net   support@dreamreport.com 

Chapter 1. Creating a Dream Report Project  
The following is an overview of the major steps and workflow when creating a project in Dream 

Report: 

http://www.dreamreport.com/
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Step 1. Start Dream Report  

After installing and rebooting the Dream Report machine, you are ready to start Dream Report 

Studio.  

Double-click the Dream Report Studio icon on the Windows desktop, or from Start > ODS 

> Dream Report > Dream Report Studio.   As a new user, either create a New Project, or 

Open Existing Project, and explore one of the Dream Report Demo projects (included 

with the install):    

 

  

 Notes on the using Demo project: 

For first-time Dream Report users, we highly recommend that you open the existing Demo 

project(s), and explore the project and report configurations in Dream Report Studio.  To 

run the Demo project, click the “Run Project” icon in the left-side toolbar in Studio.  After 

a few seconds, the RUNTIME MANAGEMENT CONSOLE (RMC) will automatically open 

once the project starts up.  You can select specific Reports in the AVAILABLE REPORTS 

pane and generate them with REPORTS controls.  Note – select Generate Files, then select 

Open Generated Files.   

 

Use the Demo project as a reference when developing your own reports – every feature 

of Dream Report is covered in the Demo reports. 

 

http://www.dreamreport.com/
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Step 2. Create a New Project 

When Dream Report Studio opens, select “New Project”, and give the project a name.  Click “OK” 

and a project (reporting application) will be created in a new directory under \ODS\Dream 

Report\Project, along with all necessary subdirectories and files. 

 

Step 3. Configure Communication Driver(s) 

After the new project is created, the Dream Report Communication Configuration Wizard will open 

automatically (it can be opened either from the Logger Studio or from the Report Designer Studio 

menu, by clicking the "Driver Configuration" button). This is where you can configure one or more 

communication drivers to real-time data sources, historical data archives, and/or historical alarm 

and event archives.  To do this, select an appropriate communication driver from the list: 

 

1  

2  

3  

4  

 Note on Running without a License: 

When Studio opens, either register and activate your license (from the Help menu), or 

work in “demo” mode.  If unlicensed, Dream Report will run in a 100-tag demonstration 

mode for 30 minutes at a time.  Contact Ocean Data Systems (sales@dreamreport.com) 

or your local Dream Report distributor for a 30-day trial license. 

 

http://www.dreamreport.com/
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1 Select the type of the data source from the “Data Source” tree (the first browse level 
will be the list of the data source vendors, displayed as folders). 

2 Give a logical name to the selected driver. 

3 Configure the selected driver.  The "Configure" button will open the specific driver 
configuration window. Each driver has its own configuration user interface, which 
depends on the specific protocol needs. If a driver doesn't have any configuration 
interface (i.e., no additional configuration is needed), that button will be disabled. 

4 Add the selected/configured driver to the list of defined drivers by Clicking “Add” 

Repeat steps 1 – 4 for additional drivers, if needed. 

Note: When changing the definition of an existing driver, please be aware that the name of the 
existing driver can NOT be changed. 

 
 

Step 4.  Data Logging (optional) 

Dream Report allows connecting to real-time data sources and log that data from the external source 
into the Dream Report internal history database. Natively, SQL Server (preferred) or MS Access is 
supported for the Dream Report database, but other databases like Oracle and MySQL can be used 
as well through ODBC. 

By default, an MS Access database (<ProjectName>.mdb) will be created and used.  However, Access 
should not be used in a product system due to several limitations.  We suggest you change the 
project database to MS SQL Server (or SQL Server Express), MySQL or Oracle) – this change can be 
made in the Project settings > Database Definition section (refer to Chapter 4. Project Tools and 
Customization in this guide.) 

 

Using Logging Groups, you can split different data items into groups and define separate logging 
conditions for each group of data items. 
  

 NOTE:  Data logging is only needed if connecting to Real-time data sources.  External 

(historical) data sources do not require logging groups, as the data has already been 

logged/archived externally to Dream Report. 

http://www.dreamreport.com/
mailto:contact@dreamreport.net
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To create Logging Group(s): 

1. Click on the Logger Studio tab in Dream Report Studio  
2. Right-click in the left top panel and add an Item group using the right-click context menu, or 

by clicking the “Add Item Group” button above.  

  

1 Logger Studio is a user interface to configure all data and alarm communication and 
logging. 

2 Data Items is the section of the Logger Studio where you can specify data logging 
conditions. 

  

 

  

1 

2  

2  

http://www.dreamreport.com/
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When the “Add Item Group” window opens, configure the logging group as follows: 

  

1 Define general properties of a group: logical (unique) name, short description (if 
needed), data source (to include items into the group), data items from that data source, 
to be logged as part of this group. 

2 Select the logging mode (“Record Rate”) and the logging schedule for the group.  All 
items in this group will be logged at the same rate and with the same conditions. 

3 If you need to log data on a pre-defined condition, use this section (“Record Conditions”) 
to define this condition. Then, items from the entire group will be logged only if this pre-
defined condition is true. 
Note: If the group logging schedule is defined, that data will be logged only when the 
logging period is active and the condition is TRUE. If a group has no schedule defined, 
then, data will be logged when the condition is TRUE. 

4 Click OK and the data item group will be configured for logging. 

  

1

3

4

2
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You can verify communications with the real-time data source by selecting an Item 
Group in the left panel, and then click “Start Monitoring” or the “Force Read” button on 
the right-side Item List. 
 

Step 5. Create Data Model(s) 

Data Models allow the user to organize and structure tags (data items) from one or more data 

sources in a logical or hierarchical (folder-based) structure, as well as rename tags with meaningful 

"aliases", if needed.   Tags can be organized in a meaningful hierarchical (folder-based) structure.  

While Data Models are not required, we highly recommend you use them as a way to simplify tag 

browsing. If using Dream Report Dashboards, Data Models are required. 

Launch the Data Model configuration window from the Data Models icon on the left-side Quick 

Launch toolbar: 

 

 

1 Click the “Add” button to add a new Data Model (you can create multiple Data Models, 
if needed) 

2 Double-click on the Data Model name to rename it to a meaningful name (no spaces) 

3 Click the “Configure” button to open the Data Model Driver Configuration window 
 

  

1

2

3
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When the Data Models Driver Configuration window opens, configure the Data Model as follows: 

 

1 Right-click to “Insert a new Folder”, to create one or more folders (if needed). Folders 
can be nested under other folders.  Double-click on a folder name to rename it. 

2 Select data source(s), and then drag-and-drop data items (tags) to the appropriate 
folder(s) on the right side.  A tag may exist in multiple folders. 

3 Optionally, double-click on an item name (on the right side) to rename the item. 
 

  

1
2

3
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When configuring a reporting object, Tags in a data model can be accessed like any other data source: 

 

Step 6.  Batch Definition (optional) 
 
If your report is for a batch process, where the exact time period and duration are not known in 
advance, but are tied to a “unit of production” – e.g., a specific Batch ID, Roll #, Work Order, Test ID, 
etc. - you can use the batch mechanism of Dream Report to determine the start and end times.  
 
A Batch can be defined in Dream Report in 2 ways: 

1 2

http://www.dreamreport.com/
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1. By data item - if the batch ID is taken from a tag value (either from a real-time driver and 
logged to the Dream Report database, or from a tag from an external history data source). 

2. In an External Database - if the batch ID, start time and end time are explicitly logged in 
an external database (e.g., a dedicated Batching system), Dream Report can reference 
those fields in a table/view.   

During report generation Dream Report will query the data source defined in the Batch Definition, 
recognize the start and end times of the batch and will then apply those times to the reporting 
object.  To use a Batch definition in a reporting object, select “Batch based” for the 
 time period: 

Step 7.   Create a Report 

Once you have created a new project and have configured connectivity to the data sources, you can 

start creating reports in the Dream Report Designer Studio.  Reports visually represent the logged 

and aggregated data, can be generated on a schedule, generated on an event, or manually 

generated, and can be automatically distributed in different ways and formats (PDF, Excel, CSV, Web, 

Printer, and Email).  Reports can be single-or multi-page with a variety of data objects (charts, tables, 

single calculations, etc.) and can contain dynamic text objects like the report name, page numbers, 

generation timestamp, etc.  You can add, delete or rename a report by right-clicking on the report 

tree in the Dream Report Designer Studio: 

http://www.dreamreport.com/
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In this step you can configure output properties of your report. To configure report settings, right-

click on the report tree in the Report Designer Studio and select Report Settings from the context 

menu (2) – or, simply double-click on the report name in the list. 

 

The “Report Settings” dialog window will be opened. The left tree will contain a list of reports, that 

will be defined in the project. Panels on the right will display settings for the selected report in the 

tree. If the report selection is changed, the panel will be updated with data from the selected report. 

 

1

 
2
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1 Report Name – define a unique name for your report. You can also configure 

storage and maintenance of report files in the General section. 

2 Report Name Format – define how file names for an output file will be generated 
(the report file naming rule will be applied both PDF, Excel, CSV and XML report 
files).   

3 Report Time Definition – define an automatic report generation schedule: 
generation on schedule or periodic generation. 

4 Generate Report on Event – configure an event-based report generation (based on 
a value from a real-time data source) and define different generation rules on event 
for different report instances. 

5 Report File Format – configure report output file format settings, and the report 
distribution settings (print, email, etc.) 

 

  

1

2 3 4 5
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      TIP: The configuration of all reports in the project can be changed in one window without closing 

and reopening it again. Clicking on another report in the tree in the left part of the dialog window 

will automatically update the dialog window with the settings of the selected report. 

 

Step 8.  Designing and Configuring a Report 

Once you have configured the main settings for a report, you can start designing it in the Dream 
Report Designer Studio. 

1. From the “Home” tab, you can add static objects, static text, images (dynamic or static), 

background images and colors, align objects, and apply general display options such as fonts, line 

colors, etc.   

 

2. In the Dream Report Designer Studio Elements toolbar you can select the dynamic objects to 

display your data.  Click on an object to select it, then using you mouse, draw a rectangle on the 

report where you want to place the object: 
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Dream Report offers various types of dynamic objects to display process analysis: 

 

Single Data Object: enables you to extract and calculate Current value, Last, Min, 
Max, Average, Sum, Duration, Integral, On Time, Availability, Deviation, etc.  The 
result will be a single value on the report. 

 

Compound Object: enables you to apply predefined statistics (Min, Max, Sum, 
Average and Standard Deviation) to 2 or more single data objects on a report.  The 
result will be a single value on the report. 

 

Expression Object: enables you to do free-form mathematical calculations, logical 
expressions, and custom scripts on your data.  The result will be a single value on the 
report. 

 

Item Table: enables you to display an array of values from one or more data items 
within a specified value range, which were logged during the specified time period.  
This is a quick way to display raw data in tabular format, with minimal formatting. 

 

Alarm Table: enables you to use historical alarm data sources, apply alarm filters, and 
display them in a pre-formatted table specific to alarm data. 

 

SQL Table: enables you to define custom SQL queries and visualize the result as a 
table with predefined parameters.  The result is a highly-customizable table. 

 

Automatic Statistical Table: enables you quickly summarize large amounts of data in 
a grid.  Select tag(s) from one or more data sources, set a common time or batch 
period, and select the statistics to be calculated and displayed. 

 

Step Table: enables you to create a table over a time period, with a predefined time 
for each row (step) in the table, and perform calculations over each step period. 

 
Free Table: enables you to build customized table (grid) mixing text, dates and 
statistics in each “cell” of the grid. 

 

Pie Graph: enables to compare and display alarms or statistics (current, last, Min, 
Max, Average, …) in a pie chart. 

 
Bar Graph: enables you to display alarms or statistics by period in a bar graph 

 

Chart: enables you to create a multi-line chart, displaying raw historical or aggregated 
data as a line trend or scatter plot. 

 

Indicator: enables you to display calculated data in a predefined format.  Primarily 
used for Energy efficiency/usage ranking, but can be applied in other ways (e.g., a 
breakdown of line efficiencies.  

http://www.dreamreport.com/
mailto:contact@dreamreport.net
mailto:support@dreamreport.com


   

Dream Report Getting Started Guide  

 

21 | P a g e  

 
Web site: www.dreamreport.com     Email: contact@dreamreport.net   support@dreamreport.com 

 

Date and Time Object: enables you to display a dynamic date and/or time in the 
desired format with a pre-defined offset (if needed).  Can be used to show the report 
generation time, or the start or end of a report period. 

 

Page Number Object: enables you to display the number of the current page or the 
total number of pages in a report 

 

Dynamic Text Object: enables you to display text (from a predefined list) in a report, 
where the value is determined during report generation.  For example, the report 
name, report version, etc.  

 

Electronic Signature Object: enables you to add an e-Signature object to a report.  
Only available/visible if the Life Sciences option is licensed. 

 

Common Configuration Options: 

Most reporting objects require the following common configuration steps: 

• Enter an Object Name (must be unique to that report) 

• Select a Data Item from a Data Model or other Data Source 

• Specify a Time Period or Batch Definition for that object 

• Apply a Statistical Function or other data aggregation/correction 

• Display options under the object’s Appearance tab 

• Apply data Filtering, from the Advanced SQL Condition tab 

 

Defining Time Periods in Reporting Objects: 

You can define time period for the selected objects calculations. You can: 

• Define the start and the end of time period (either relative times, or absolute periods); 

• Select fix intervals (e.g., last 8 hours, current 1 month, etc.); 

• Use a batch definition (for batch process reporting) 

• Reference other objects on a report that contain start and end times (e.g., timestamp 
pickers) 

 
Objects on a report typically all have the same time period, but in some cases, may have different 
time periods for different objects – e.g., two charts, one showing last month’s data, and the second 
chart showing the current month’s data. 
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Time periods are specified in the “Define Time Period” section of an object: 

 

Step 9.  Saving and Generating a Report 

Once you have designed and configured your reports, it’s now time to save the reports, and start 

running the project so that the reports will be generated (on schedule, triggered, or on-demand). 

Click the “Save Project” icon  in the top-right of Studio.  At this point you can run the project by 

clicking the “Run Project” button on the Quick Launch toolbar.  

 

If the project is already running, and you add or edit a report, simply click the “Reload Reports” 

button to apply those changes to the running project.  

 

 

You are now ready to test your reports in Dream Report Runtime. 
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Chapter 2. Dream Report Runtime 
 
After your project and report(s) have been configured, you need to run your project in order to log 
data into the Dream Report historical database (if configured), and generate reports.  A Dream 
Report project can run by means of the Runtime Manager (Runtime control service) module. This 
module can run either as a service (launched on the PC start) or as an application (launched on a 
user Windows login).  
 

Step 10. Runtime Management and Report Generation 

To control all operations related to the Runtime Manager (runtime service) and report generation, 
the Runtime Management Console (RMC) is used.  With the Runtime Management Console, you 
can manage the project in Runtime - i.e., reloading the project/reports, generating reports on 
demand, shutting down the project, providing access to different project options (project folders, 
Web portal, IIS configuration), Dream Report license info, help documentation, while the project is 
running.  
 
This chapter describes the mechanism of running Dream Report project(s), logging data and 
executing report(s). 
 

Dream Report Runtime Manager enables: 
 

• Data logging 
• Standard/dynamic report generation 
• Multiple runtime options and runtime management tasks 
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1 Select a project, to which the Runtime Management Console will be connected.  

2 Reload the project or the reports, or shut down the project. 
NOTE: You can also reload project/reports directly from the Dream Report Studio by 
clicking on the Reload Project or Reload Reports command buttons.  

3 Access different functionalities and runtime management tasks directly from the RMC 

4 Generate the selected report. There are 4 options for the report generation format: PDF, 
Excel, CSV and XML – select the format(s) needed for on-demand generation 

5 Open the generated report in one of the 4 formats (PDF, Excel, CSV or XML) 
6 Open the Dynamic Report Generator (DRG) window for dynamic report generation. 

7 Click to view the current status of the project’s report generation queue (i.e. list of 
reports currently being generated or ques to be generated.) 

 

You can generate reports on demand by using the Dynamic Report Generator, where you can 

dynamically specify the define time period for the report before generating the report (this is a useful 

report testing tool): 

1
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Chapter 3. Dream Report Web Portal 
 
Dream Report’s web portal (“DRWeb”) enables users to browse reports from the currently running 
project, visualize any existing report from the project, generate any report on demand, enter manual 
values (data) into the Dream Report database or use them for calculations or filtering for regular 
reporting, generate ad hoc reports, and to view Dream Report Dashboards. 

 
Reports can be visualized in Dream Report Web Portal in the following formats: 

 

• PDF format (a history of those reports will be displayed)  

• Excel format (history of those reports will be displayed) 

• XML format (history of those reports will be displayed) 

• Web (HTML5) format (contains web pages with reports, no history of these reports is displayed).   
 

Step 11. Configure the Dream Report Web Portal 
 

Configuring the Web Portal 
 
Before loading the Web Portal, you need to define basic portal settings and configure the portal in 
Internet Information Server (IIS).  To configure the web portal with all default settings, click 
“Configure IIS” in the PROJECT ACCESS section of the Runtime Management Console: 
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Click “Configure IIS”, and then “OK” when the 
following pop-up opens.  The web portal will be 
configured within a few seconds, and be ready to use. 
 
The web portal can be customized from the Web 
Configuration section in Project Settings in Dream 
Report Studio. 
 

 

Opening the Web Portal 
 
The web portal can be opened by either clicking “Open Web Portal” in the PROJECT ACCESS section 
of the Runtime Management Console, or by opening a web browser to the following URL: 
http://localhost/drweb.  To load the web portal on a remote computer you need to open the web 
page http://<IP address or DR Computer Name>/drweb.  This will automatically open the welcome 
page of the Dream Report web portal. 

 

  
1 Report Names and Report Folders – all reports and report folders will be displayed (or 

a subset, if User Management/security is being used).  Click on a report name to 
open/generate that report. 

2 Report Formats – click on the appropriate format icon to open the most recently 
generated report in the selected format, or generate the report Web report on demand. 

3 Description – if a report description was entered in the report settings in Studio, it will 
be shown here. 

4 Generated on – for PDF/Excel/XML files, the last time of generation will be shown.  For 
web reports, since they are generated “on demand”, no date/time will be shown. 

4 New Report – clicking the “New Report” icon (Pie chart) will force a new report to be 
generated.  Clicking the “New Dynamic Report” icon (Clock) will first open date range or 
batch picker, from which the user can specify a custom date range or batch, and then 
generate the report with those times. 

  

1 2
3

4
5
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When a report opens in the web portal, a list of previously-generated reports will be shown, 

organized by month and year.  Clicking on any report in the report history will open that report file 

immediately (i.e., it not be generated again).  Since Web-formatted reports are always generated 

on-demand, no history for the web reports will be shown: 

 

 

  

 Note:  

To have access to a project in the Dream Report Web Portal, each time a new project is started, 

you will have to configure IIS (Internet Information Services) for that project manually. For this 

you should click on the Configure IIS button either in the Web Configuration dialog box of the 

Project Settings section in the Dream Report Studio, or in the Runtime Management Console 

dialog window. 
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Chapter 4.  Project Tools and Customization 
 
Project Customization Settings 
 
As shown earlier in this guide, creating a new Dream Report project is a simple process, and you can 
get started right away with all the default settings.  Should you wish to change various Project 
Settings, go to the “Project” tab in Dream Report Studio - click the General icon (or any specific 
setting): 

 

The Project Settings window will 

open: 
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1 Project Name – define general project-related information, like project name, 
author and description. 

2 User management – to secure a project, define user/user group authorization and 
authentication for access to different project modules, and then check “User 
Authentication”. 

3 Generation Priorities – specify how Dream Report manages priorities when 
generating reports in different modes and when generating different reports in the 
same mode. 

4 Database Definition – configure the Dream Report historical database, for data 
logging within the project. (Data can be logged natively to either MS SQL Server or 
MS Access, or to any open database using the ODBC interface). 

5 Web Configuration – customize the Dream Report Web Portal 

6 Project Paths – configure destination folders, where various project files will be 
stored 

7 Log File – define a log file to log online errors and information.  Very useful in 
debugging or auditing a project. 

8 Hotbackup Configuration - define the local reporting runtime node as a redundant 
station, coupled with the main station.  

9 Localization – set the default language of the interface (i.e. all dialog boxes and 
menus), configure date/time/week, and display other localized settings for the 
report objects. 

 

Project Tools 

 

This section describes several of the modules and functionality which you can use in Dream Report to 

customize functionality and accomplish various tasks that may be needed for your reporting application. 

Virtual Report Instances - use Virtual Report Instances to create multiple pre-defined instances of the same 

report template, where each instance will use the same template but with different pre-defined tags.  

Useful when you need to create identical reports (e.g., batch reports for various reactors) that differ only in 

their data items, and report generation triggers. 

Custom Archive Import Tool - use the Custom Archive Import Tool to access any available external archive 

(using any defined Historical Data driver) and periodically import its data (values) into the Dream Report 

internal database, which makes the data available for reporting from the standard Dream Report database.   

Setpoint Analysis - use Setpoint Analysis for smart analysis of thermal and other processes, where the 

process is based on a setpoint stability analysis. 
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Tag Dictionary - use the Tag Dictionary to manage all tags used in a reporting project.  You can search, 

change, replace tag items in an easy and manageable way. 

DSN Manager - use the DSN Manager to configure and manage all database DSNs (data source names), 

used in the project – typically used with direct SQL queries and the Advanced ODBC drivers. 

Aggregated Data Filter - this feature allows you to create smart data retrieval definitions, such as sample-

based data retrieval (e.g., the 1st value every 15 minutes) and data aggregation, which can then be applied 

to historically-logged data in many reporting objects. 

Multi-Tag Aggregation - Multi-Tag Aggregation allows Dream Report statistical objects to perform 

operations not only with one tag, but to perform operations with arrays of values from different tags – i.e., 

you can create Multi-tag Expressions (MTE).  Once an MTE has been created, it can be used in any chart, 

table or item field, just as if it were a raw data item/tag. 

Analytic Data Server (ADS) - the Analytical Data Server is a Dream Report service that exposes data from 

the internal System real-time values driver to external/third-party applications, via an OPC-DA server. 

Pivot Groups - this function allows you to repeat one or several objects (a group) for pre-defined steps (time 

sub-periods or other conditions) on a report. This functionality is similar to a Step Table, However, while a 

Step Table can repeat lines ("steps") with predefined calculations for each time-sub-period in a single table, 

Pivot Groups will repeat complete a group of objects for each predefined step. For example, you might have 

a line chart and summary table of process parameters, that you want repeated in a report for each month 

of the year. 

 

Customer Feedback 
Dream Report welcomes your feedback. For comments and suggestions related to this and other 
manuals, contact: contact@dreamreport.net.    
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